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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
PIC10(L)F32X Development Board. Items discussed in this chapter include:
• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Revision History

DOCUMENT LAYOUT
This document describes how to use the PIC10(L)F32X Development Board as a 
development tool to emulate and debug firmware on a target board, as well as how to 
program devices. The document is organized as follows:
• Chapter 1. “PIC10(L)F32X Development Board” – An overview of the 

PIC10(L)F32X Development Board, PCB layout, parts and how to connect the 
provided jumper wires to the board.

• Chapter 2. “Example Projects” – Projects that describe how to implement the 
Numerically Controlled Oscillator (NCO), the Complementry Waveform Generator 
(CWG), and the Configurable Logic Cell (CLC).

• Chapter 3. “Troubleshooting” – Provides resolutions for solving common 
problems associated with using the PIC10(L)F32X Development Board.

• Appendix A. “Hardware Schematics” – Illustrates the PIC10(L)F32X Develop-
ment Board hardware schematic diagrams.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
© 2012 Microchip Technology Inc. DS00000n-page  4



Preface
CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [,
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

© 2012 Microchip Technology Inc. DS00000n-page 5
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WARRANTY REGISTRATION
Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING
This user’s guide describes how to use the PIC10(L)F32X Development Board. Other 
useful documents are listed below. The following Microchip documents are available 
and recommended as supplemental reference resources.
PICkit™ 3 Microcontroller Programmer User’s Guide (DS51795)
Consult this document for instructions on how to use the PICkit 3 Microcontroller 
Programmer hardware and software.
MPLAB® ICD 3 In-Circuit Debugger User’s Guide (DS51766)
Consult this document for information pertaining to Microchip’s In-Circuit Debugger, 
MPLAB ICD 3. MPLAB ICD 3 utilizes the in-circuit debugging capability built into the 
Flash devices.
PIC10(L)F32X Data Sheet (DS41585)
Consult this document for information regarding the PIC10(L)F32X 6/8-pin 
Flash-based Microcontroller.
MPLAB® IDE, Simulator, Editor User’s Guide (DS51519)
Consult this document for more information pertaining to the installation and features 
of the MPLAB Integrated Development Environment (IDE) Software.
DS00000n-page 6 © 2012 Microchip Technology Inc.



Preface
THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers and other language 

tools. These include the Hitech C16, MPLAB C18 and MPLAB C30 C compilers; 
MPASM™ and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 
object linkers; and MPLIB™ and MPLAB LIB30 object librarians.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debugger, ICD3, PICkit™ 3.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
the MPLAB ICD3 device programmers and PICkit™ 3 development programmers.
© 2012 Microchip Technology Inc. DS00000n-page 7
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PIC10(L)F32X Development Board
CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: 
http://www.microchip.com/support.

REVISION HISTORY

Revision A (April 2012)
• Initial Release of this Document.

TROUBLESHOOTING
See Chapter 3. “Troubleshooting” for information on common problems.
DS00000n-page 8 © 2012 Microchip Technology Inc.
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Chapter 1.  PIC10(L)F32X Development Board
1.1 INTRODUCTION
The PIC10(L)F32X Development Board is intended to be a learning tool for individuals 
interested in PIC® microcontroller design.
The PIC10F322 microcontroller is ideal for use on the PIC10(L)F32X Development 
Board due to their small size, high efficiency, speed and peripheral configurations. 
This chapter introduces the PIC10(L)F32X Development Board. It describes the PCB 
layout, parts and electrical connection to the PICkit™ 3 Flash Programmer and MPLAB 
ICD 3 In-Circuit Debugger. 

1.2 HIGHLIGHTS
This chapter discusses:
• Quick Start Guide
• The PIC10(L)F32X Development Board Kit Contents
• The PIC10(L)F32X Development Board Layout
• Required Tools
• PIC10(L)F32X Development Board Setup

1.3 QUICK START GUIDE
The PIC10(L)F32X Development Board is programmed at the factory with a 
demonstration program. The board doesn't need to be configured in any way in order 
to use the demonstration program. Once the board is powered up, the brightness of 
LED (D2) may be varied using the potentiometer (POT1). LED (D1) is powered as long 
as the PIC10F322 is operating, and will thus vary with the supply voltage.

Board Setup
There is no setup for this development board to operate.

Board Power-Up
Supply power to the board in one of the following ways:
• Connect a 2.3-5 VDC supply using J4 (see Figure 1-1)
• Use the power supplied by the PICkit 3 or MPLAB ICD 3 programmers.

Demonstration Program
After applying power to the PIC10(L)F32X Development Board, LED (D1) will automat-
ically turn on. Turn POT1 clockwise to increase the brightness of LED (D2). Press 
switch (SW1) to turn both LEDs D1 and D2 off, release switch (SW1) and LED's D1 and 
D2 will turn on.
© 2012 Microchip Technology Inc. DS00000A-page  9



PIC10(L)F32X Development Board User’s Guide
FIGURE 1-1: QUICK BOARD SETUP

1.4 PIC10(L)F32X DEVELOPMENT BOARD KIT CONTENTS
The PIC10(L)F32X Development Board contains the following items:
1. PIC10(L)F32X Development Board Printed Circuit Board (PCB) with all compo-

nents installed
2. Pre-programmed PIC10F322 device

1.5 PIC10(L)F32X DEVELOPMENT BOARD LAYOUT
The PIC10(L)F32X Development Board is shown in Figure 1-2.
A PIC10F322 microcontroller is populated on the top center of the development board 
under the identification label U1. The PIC10F322 has 4 available I/O pins that are 
initially connected to the four major component on the board. The initial connections 
connect to the following components:
• Switch 1 (SW 1) – 1 pin: MCLR (pin 6) of microcontroller
• Pot 1 (POT1) – 1 pin: RA2 (pin 4) of micro-controller.
• LED (D1) – 1 pin: RA1 (pin 3) of micro-controller.
• LED (D2) – 1 pin: RA0 (pin 1) of micro-controller.

PIC10F32X Development Board
(Part # AC103011)
DS00000A-page 10 © 2012 Microchip Technology Inc.



PIC10(L)F32X Development Board
Should you choose to use the board to experiment on your own, the board allows you 
the flexibility to do so. You can try experimenting with peripherals not covered in the 
projects in Chapter 2. “Example Projects”.
A prototyping area is provided, with ground (GND) and supply voltage (VDD) connec-
tions on the left and right sides, to expand and experiment with the capabilities of the 
PIC10(L)F32X Development Board.

FIGURE 1-2: PIC10(L)F32X DEVELOPMENT BOARD HARDWARE LAYOUT

1.6 REQUIRED TOOLS
One of the following programming tools is needed in order to complete the projects in 
the next chapter:
• MPLAB® IDE
• PICkit™ 3 Microcontroller Programmer (Part# DV164131)
• MPLAB® ICD 3 In-Circuit Debugger/Programmer (Part# DV164035)
Figures 1-3 and 1-4 illustrate how to connect each of these tools to the PIC10(L)F32X 
Development Board.

1.7 PIC10(L)F32X DEVELOPMENT BOARD SETUP
There is no setup for this demo board to operate.

FIGURE 1-3: CONNECTING THE MPLAB® ICD 3 TO THE PIC10(L)F32X 
DEVELOPMENT BOARD

Prototyping area

Power Supply Jumper PICkit™3 header

POT1

Switch 1
PIC10F322
microcontroller

Cut traces here to
isolate D1, D2, POT1,
and SW1 from PIC® MCU

Break board here to
separate the prototyping
area from rest of demo

LEDs
© 2012 Microchip Technology Inc. DS00000A-page 11
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FIGURE 1-4: CONNECTING THE PICkit™ 3 TO THE PIC10(L)F32X 
DEVELOPMENT BOARD

1.8 GENERAL PIC10(L)F32X DEVELOPMENT BOARD INFORMATION

Power Supply Maximum Ratings
Supply voltage: 5 VDC

1.8.1 Experimentation
The PIC10(L)F32X Development Board was designed for your experimentation. After 
completing the projects in Chapter 2. “Example Projects”, please experiment freely 
on your own. Electronic components, other than those provided in the kit, may be 
used..

Note: Although reasonable measures have been taken to protect the board from 
the occasional mistake, THE BOARD MAY BE DAMAGED if proper design 
techniques are not used and special attention to the schematic is not made.
DS00000A-page 12 © 2012 Microchip Technology Inc.
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1.9 HEADER/JUMPER FUNCTIONS

TABLE 1-1: HEADER/JUMPER FUNCTIONS

Header/
Jumper # Description

J1* Programming header for PICkit 3 programmer.

J2 Connects to header J3 and connects components SW1, POT1, D1, and 
D2 to the appropriate pins of the microcontroller.
Traces connecting J2 to J3 can be cut to isolate these conponent from 
the microcontroller.

J3 Connects to header J2 and connects components SW1, POT1, D1, and 
D2 to the appropriate pins of the microcontroller.
Traces connecting J2 to J3 can be cut to isolate these conponents from 
the microcontroller.

J4* External voltage and ground connections.
© 2012 Microchip Technology Inc. DS00000A-page 13
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Chapter 2.  Example Projects
2.1 INTRODUCTION
The following projects provide examples of how to use the various PIC10F322 micro-
controller peripherals. The projects are presented sequentially so that you will build 
knowledge as you progress from one project to the next.
Those who are new to programming PIC® microcontrollers should pay special attention 
to the comments in the source code for each of the projects. Though these projects are 
not intended to teach you the Microchip Assembly language, you will be able to get a 
good grasp of Microchip’s Assembly language by reading the source code.
Microchip has published application notes and other documents covering the 
applications in each of these projects. These documents can be found on the provided 
CD-ROM. Any updates to the applicable documents are available on Microchip’s web 
site. Please reference these documents while exploring each of the projects.

2.2 LOADING PROJECTS IN MPLAB® IDE
The firmware for the projects are arranged in corresponding project folders located at: 
http:\microchip.com\dev-tools\Pic10(L)F32x.

Opening a Project
1. Start MPLAB IDE.
2. In the menu bar choose File -> Open Workspace.
3. Find the project folder.
4. Open the *.mcw file.
The project window for Project 1 is shown in Figure 2-1.

Note: See Section 1.7 “PIC10(L)F32X Development Board Setup” for 
instructions on how to setup the board to its “initial” condition prior to doing 
projects.
© 2012 Microchip Technology Inc. DS00000A-page  15
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FIGURE 2-1: PROJECT WINDOW

2.3 EXAMPLE PROJECTS

PIC10(L)F32X Development Board Projects:
• Project 1: Hello World (LEDs flashing)
• Project 2: LED Dimmer

2.3.1 Project 1: Hello World (LEDs Flashing)
When learning to use a new computer language, the first practical lesson traditionally 
instructs the user how to light up one or more LEDs. Staying with tradition, this project 
will make your PIC10(L)F32X Development Board flash the LEDs.

Objectives
1. Use the Pic10F322 device to read a potentiometer input.
2. Implement the NCO and CWG modules.
3. Toggle the LEDs fast or slow by adjusting the potientiometer.

Applicable Technical Documents
PICkit™ 3 Programmer/Debugger User’s Guide (DS51795)
MPLAB® ICD 3 In-Circuit Debugger User's Guide (DS51766)

Development Board Set-up
None

Instructions
Adjust POT1 to toggle the LEDs (D1 and D2) on and off fast or slow.
DS00000A-page 16 © 2012 Microchip Technology Inc.
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Discussion
By Adjusting POT1, the NCO increment value will adjust accordingly. This will increase 
or decrease the NCO output signal pulse width, which will increase or decrease the 
NCO frequency. Thus, as the NCO output signal goes through the CWG and a comple-
mentary waveform is generated, LEDs D1 and D2 will flash on and off with varying fre-
quency.

2.3.2 Project 2: LED Dimmer
If you have lights at home that can be adjusted from very dim to very bright, then you 
are familiar with the application we will create in this project. The Pulse Width Modulator 
(PWM) module on the PIC10F322 will be used to adjust the voltage level from the 
potentiometer to the voltage level to the LEDs. When the duty cycle of the PWM signal 
is increased or decreased via the potentiometer, the LEDs will go from dim to bright.

Objectives
1. Use the internal PWM and CWG modules.
2. Have each LED adjust from dim to bright.

Applicable Technical Documents
PICKit™ 2 Programmer/Debugger User's Guide  (DS51795)
MPLAB® ICD 3 In-Circuit Debugger User's Guide (DS51766)

Jumper Configuration
None

Instructions
After programming the PIC10F322 MCU, adjust the potentiometer (POT1) clockwise 
and watch LED D1 get brighter.  Adjusting POT1 counter clockwise will cause LED D1 
to get dimmer, and cause LED D2 to get brighter.

Discussion
By Adjusting POT1, the PWM duty cycle value will adjust accordingly. This will increase 
or decrease the PWM output signal pulse width, which will increase or decrease the 
PWM frequency. Thus, as the PWM output signal goes through the CWG and a 
complementary waveform is generated, LEDs D1 and D2 will flash on and off with 
varying frequency.

Note: See Section 2.2 “Loading Projects in MPLAB® IDE” for the location of 
the source files for this project and all subsequent projects.
© 2012 Microchip Technology Inc. DS00000A-page 17
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Chapter 3.  Troubleshooting
3.1 INTRODUCTION
This chapter describes common problems associated with using the PIC10(L)F32X 
Development Board and steps on how to resolve them.

3.2 COMMON PROBLEMS

3.2.1 VDD Is Below 2.3V
The board must be powered by one of the following:
• An external power supply connected to the appropriate pins of J4. 
• Use the power supplied by the PICkit™ 3 or MPLAB® ICD 3 programmers.
Supplying less than 2.3 VDD at J4 will not allow the microcontroller (U1) to function 
properly.

3.2.2 PIC® MCU Does Not Run After Programming By The MPLAB 
ICD 3

When using the MPLAB ICD 3 as a programmer, the microcontroller will not run unless 
you disconnect the MPLAB ICD 3 or release the MPLAB ICD 3 from Reset. Figure 3-1 
shows the “Release From Reset” button.

FIGURE 3-1: RELEASE FROM RESET BUTTON
© 2012 Microchip Technology Inc. DS00000A-page  19
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Appendix A. Hardware Schematics
A.1 INTRODUCTION
This appendix contains the PIC10(L)F32X Development Board Hardware Schematic 
Diagram.

FIGURE A-1: PIC10(L)F32X DEVELOPMENT BOARD HARDWARE 
SCHEMATIC DIAGRAM

VPP/MCLR VPP
VDD

VPP/MCLR

PIC10F322

VDD
RA3/MCLR/VPP

VSS

V
P
P
/M
C
LR

ICSP™
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